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Según se observa en el índice, se va a distinguir tres fases en la guía, que

coincidirán con las de desarrollo de una simulación en Pspice. Una primera de

introducción: entrar en el programa y prepararlo para el trabajo. La segunda será la

elaboración del esquema del circuito que se esté estudiando en el Schematics con el que

trabajará Pspice, y finalmente la elaboración del análisis y cuarta, su representación.

Acompañan la guía tres útiles ejemplos que sirven de referencia para el posterior uso de

Pspice.



2

RESEÑA HISTÓRICA

El origen del simulador SPICE puede remontarse a hace más de treinta años. A

mediados de la década de los 60 IBM desarrolló el programa ECAP, que más tarde

serviría como punto de partida para que la Universidad de Berkeley desarrollara el

programa CANCER. Hasta principios los años 70 los circuitos electrónicos se

analizaban casi exclusivamente de forma manual, mientras que de forma progresiva, la

complejidad de éstos iba en aumento. Fue en ese momento cuando un grupo de la

Universidad de Berkeley, tomando como base el programa CANCER, desarrolló la

primera versión de SPICE (Simulation Program with Integrated Circuits Emphasis). Un

simulador de propósito general que permitía analizar sobre grandes ordenadores y

workstations, circuitos analógicos sin necesidad de montarlos físicamente.

En SPICE el circuito y análisis requerido es descrito en un fichero de texto

mediante un serie de comandos y declaraciones, a este fichero se le llama fichero del

circuito. La sintaxis de las declaraciones permite dejar parámetros sin especificar con lo

que tomarán valores por defecto. El fichero del circuito es leído por SPICE, éste

comprueba que no hay errores en las conexiones y sintaxis declaradas, y finalmente hará

la simulación.

El éxito alcanzado por el programa, así como por su utilización generalizada,

originó la aparición de numerosas versiones de SPICE. En 1984 nace de manos de

MicroSim Corporation la primera adaptación para ordenadores personales: PSpice.

Desde entonces, PSpice ha ido renovándose hasta llegar a la versión número 9, de

reciente lanzamiento. Esta revisión del simulador es la primera desde la fusión de

MicroSim Corporation y OrCAD.

SPICE está considerado como el estándar en análisis electrónico. Es referencia y

base de numerosos simuladores del mercado.
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1. INTRODUCCIÓN

1.1 ¿CÓMO EMPEZAR?

Para empezar, primero hay que abrir el programa Capture CIS Demo de la

carpeta Orcad Demo.

Una vez abierto el programa, pulsando ">File>New>Project..." seleccionamos el

tipo de proyecto que queremos abrir, para comenzar a trabajar.

Hay que poner un nombre al proyecto, y seleccionar "Analog or Mixed-Signal
Circuit Wizard". Esta selección es realmente importante, ya que de no hacerla, será

imposible ejecutar normalmente Pspice.
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Tras haber escogido un nombre para el proyecto, así como el tipo de esquema

que se quiere realizar, el programa pedirá qué tipo de librerías de componentes

queremos instalar. Las librerías instaladas aparecerán en el lado de la derecha, mientras

que las que no lo están lo harán en la izquierda. Para seleccionarlas, basta con marcarlas

una por una e ir pulsando "Add". Pspice permite manejar hasta un máximo de ocho

librerías a la vez. Se pueden seleccionar todas las librerías, aún así necesariamente habrá

que escoger las siguientes: "analog", "source", "eval", "special".

Una vez realizado el proceso, ya se puede comenzar a ejecutar Pspice.

1.2 ANTES DE EMPEZAR EL ESQUEMA.

Aunque sean funciones muy conocidas, antes de empezar vamos a dar un

pequeño repaso a los distintos iconos que aparecen en la barra de tareas principal.

Los tres primeros iconos son los que representan las opciones de comenzar un

proyecto nuevo, abrir uno ya comenzado y guardar el que este en curso. Sigue la opción

de imprimir, cortar, copiar y pegar, así como deshacer y deshacer lo deshecho.

Acto seguido, es posible abrir un pequeño desplegable, que brinda la opción de

escoger alguno de los últimos componentes usados en el esquema. Los cuatro siguientes

iconos son los de manejo del zoom. Es muy útil comenzar sin tocarlos, para una vez

hayamos puesto los primeros componentes, marcarlos y dar al zoom de acercar, de esta

manera no habrá que hacer ningún ajuste extra. El resto de los iconos no están

disponibles en la versión de demostración, salvo el de ayuda y el de manipulación de

ficheros.
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2.1 ELEMENTOS PASIVOS

2.1.1 ESCOGIENDO LOS ELEMENTOS.

Para colocar un elemento pasivo en nuestro esquema del circuito, tenemos varias

opciones. Se puede hacer abriendo de la barra principal ">Place >Part", o bien

pinchando en el icono de la barra de herramientas que se encuentra en la izquierda,

desplegaremos la ventana llamada "Place Part".

Una vez tengamos delante dicho desplegable, sólo queda seleccionar el elemento

que queramos utilizar. Para encontrar el componente necesario basta con escribir las

primeras letras de aquel. Por ejemplo, tecleando "r" aparecerán todos los elementos que

comiencen por dicha letra. Si pulsamos sobre "Libraries", se pueden seleccionar

bibliotecas de elementos específicos para diferentes usos (desde lógica digital hasta

micros). Un elemento no aparece si no se carga la biblioteca en la que está.

Escogido el componente en cuestión, basta con hacer doble clic sobre él para

seleccionarlo, llevarlo con el ratón al lugar donde se quiere colocar y pulsar el botón

izquierdo del mismo. Si no se desea volver a colocar ningún elemento del mismo tipo

en el esquema, después de apretar el botón derecho se selecciona "End Mode".

Nombre En PSPICE Librería

Resistencia R Analog

Capacidad C Analog

Autoinducción L Analog

Inducción mutua XFRM_LINEAR Analog

Tierra 0 Source
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En el caso del condensador y de la bobina, para hacer análisis transitorios, hay

que escoger unas condiciones iniciales. Esto se realiza en la ventana de propiedades del

elemento (para abrirla se hace doble clic con el botón izquierdo sobre el componente).

2.1.2 MANIPULANDO LOS ELEMENTOS

Los componentes se pueden manipular de distintas maneras, todas ellas

comienzan marcando con el botón izquierdo del ratón el componente deseado. Una vez

marcado éste, se pondrá de color rojo.

Para rotar, se puede o bien seleccionar ">Edit>Rotate", o bien pulsar al mismo

tiempo Ctrl+R. (Hay que tener cuidado, ya que Pspice hace las rotaciones en el

sentido contrario a las agujas del reloj, no es lo mismo rotar un polo positivo en una

dirección que en otra al igual que no son lo mismo 90º que 270º).

Para copiar, o se marca "> Edit>Copy", o se pulsa Ctrl+C. Para pegar el elemento en

cuestión, se puede optar por "Edit>Paste" o Ctrl+V.

IMPORTANTE: Como tierra hay que escoger la llamada 0/SOURCE pinchando en el

icono de tierras, que aparece en la barra auxiliar de la izquierda. Es necesario que
nuestro esquema tenga un punto de potencial definido cero, ya que si no existe,
este no se podrá simular.
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Para mover, se marca con el ratón sobre el componente, y sin levantar el dedo del

botón se desplaza al lugar de destino.

Para borrar un componente, basta con pulsar Supr.

Nota: Todos estos procedimientos se pueden seguir también para grupos de

elementos; basta con marcarlos todos a la vez dentro de un mismo cuadro con el

ratón.

     Icono marcado de "place part"      Icono marcado de dibujar cable.

2.1.3 CABLEANDO EL ESQUEMA

Una vez puestos todos los elementos en el esquema de la pantalla, hay que

unirlos con cables. Para dibujar los cables, se abre, de la barra principal ">Place >Wire"

o se pincha en el icono de la barra de herramientas de la izquierda. El puntero se

convertirá en un lápiz, y sólo quedará unir los distintos puntos haciendo clic en los

extremos. Para acabar de dibujar un tramo, hay que hacer doble clic con el botón

izquierdo. En el caso de querer dejar de usar la opción de modelar el cable, después de

apretar el botón derecho se selecciona "End Wiring".

2.1.4 DANDO VALORES Y NOMBRE

Para dar valores a un elemento pasivo hay que hacer doble clic con el botón

izquierdo del ratón sobre el valor del componente y rellenar el desplegable que aparece

en pantalla. Para darle nombre hay que hacer lo mismo sólo que cliqueando sobre el

nombre.
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2.2 ELEMENTOS ACTIVOS

La selección se hará igual, los únicos que cambian son los componentes, que

ahora serán:
Nombre En PSPICE Librería

Fuente de continua VDC Source

Fuente de alterna VAC Source

F de tens cont por tensión. E Analog

F de int cont por intensidad. F Analog

F de int cont por tensión. G Analog

F de tens cont p intensidad. H Analog

Pulso VPULSE Source

Amplificador operacional uA741 Eval

Interruptor apertura Sw_topen Eval

Interruptor cierre Sw_tclose Eval

La implantación y la manipulación son idénticas a las descritas en el caso de los

elementos pasivos, sólo que ahora tendremos que especificar unos atributos distintos.

Veamos uno por uno:

Pulso. Hay que especificar los distintos valores de tensiones, tiempos y el periodo.

La fuente producirá un pulso periódico.

   V

V1

         V2

T

               TD     TR     PW     TF

           PER

Fuente de continua. Hay que señalar cual es su tensión.

Fuente de alterna. Hay que indicar su valor de continua, y su valor de alterna.
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Fuentes de....  continua         alterna

Fuente de tensión controlada por tensión o intensidad. Hay que conectarla e

indicar su ganancia.

Fuente de intensidad controlada por tensión o intensidad. Igual que la de

tensión.

El amplificador operacional. Pspice lo llama uA741. Hay que conectarlo por las

patas 4 y 7 a una fuente de tensión que esté a 12v. Las dos entradas son 2 y 3. La

salida es 6 y trabaja igual que se ha estudiado en clase.

Interruptor. Hay que especificar el tiempo de apertura o cierre, una vez hecho esto,

el programa simulará su apertura o cierre en el tiempo especificado.

Para Pspice, el interruptor es una resistencia variable que pasa de tener un valor muy

bajo (RCLOSED) a tener uno muy alto (ROPEN) o a la inversa (sí en lugar de abrirse se

cierra), en un tiempo muy pequeño (TTRAN).

Topen

Ttran

Rclosed

Ropen

t
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3. SIMULANDO EL CIRCUITO

Pspice se puede usar para analizar con mucho detalle el esquema del circuito

previamente montado.

3.1 MARCADORES

El paso previo a ejecutar el análisis, es indicarle a Pspice, los nudos de los que

queremos conocer la evolución, tanto de su tensión, como de su intensidad. Para ello

hay que abrir ">Pspice>Markers" y seleccionar la magnitud que se quiera medir.

También se puede hacer lo mismo seleccionando el icono respectivo.

Existen tres marcadores básicos, el de tensión, el de tensión diferencial y el de

intensidad. En el caso de que se estuviera trabajando para hacer un barrido de alterna (es

decir, para hallar un bode) se pueden usar los marcadores avanzados, que medirán en

dB. Para poder abrirlos es necesario configurar el análisis como "AC Sweep" antes.

Marcador de tensión. Da la tensión de un determinado punto respecto del nudo que

hayamos marcado como tierra.

Marcador de intensidad. Da la intensidad que pasa por el punto marcado.

Marcador diferencial de tensión. Es un marcador doble; primero se coloca uno en

un punto, y luego se coloca el segundo en otro. Marca la diferencia de tensión entre

ambos puntos.

También se pueden usar marcadores avanzados (de fase, de parte real,

compleja...). Para acceder a ellos, donde se pinchan los distintos marcadores, se elige

ahora "advanced".
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3.2 CONFIGURACIÓN DE LA SIMULACIÓN

Hay que abrir "Edit Simulation Settings" para especificar que tipo de simulación

queremos hacer.

Una vez dentro del menú, se elige el tipo de análisis que se va a realizar:

Transitorio. Habrá que elegir "Time Domain". Con este análisis se podrá observar

como responde el circuito al paso del tiempo. Lo primero que se ha de hacer, es

especificar el tiempo límite hasta el que se va a realizar la simulación. Pspice, a

continuación, permite, en el caso de que la parte interesante de una función se de a

partir de un determinado momento, comenzar el análisis en cero, pero sin mostrar

resultados (mucho más rápido) y empezar a guardar datos a partir de dicho instante.

Esto se consigue con "Start saving data after". Por último se señala cual es el

intervalo de tiempo entre cada punto.
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Barrido de continua. Llamado por Pspice "DC Sweep". El programa hace un

análisis en continua realizando un barrido de la variable especificada, que puede ser

una fuente de tensión o de corriente, el parámetro de un modelo o incluso la

temperatura, en el rango de valores especificado para dicha variable. Primero se

selecciona el tipo de elemento que queremos utilizar como variable en la parte de la

izquierda del desplegable. Luego se identifica el componente en cuestión, del

esquema, y por último se ponen las características del barrido. Estas serán por orden,

valor inicial, valor final e incremento de la magnitud. Es de notar que el barrido

puede ser anidado, es decir, que varíe un elemento, y para cada paso, hacer variar

otro por ejemplo.

En la figura estamos haciendo el barrido con una fuente de tensión (V1 en

concreto). Esta tomará los valores: 0 10 20 30 40 y50.

Barrido de alterna. Permite hacer un barrido de frecuencia, utilizado para calcular

los diagramas de Bode y Nyquist, o pedir una magnitud del circuito para distintas

frecuencias de excitación senoidal (intensidad que pasa por algún elemento, tensión

en un nodo). Primero hay que especificar como se quiere el análisis: lineal o

logarítmico. En el caso de que sea logarítmico, señalar si lo queremos en decibelios

u octavas. Por último se ponen las características del barrido: valor inicial, valor

final y cuantos puntos queremos que barra el análisis.

Análisis paramétrico. Dentro de cualquier análisis se puede escoger un

componente del circuito y hacerlo variar como parámetro. Para realizarlo ver el

segundo ejemplo.
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3.3 EJECUTANDO LA SIMULACIÓN

Una vez hecho el esquema, y configurada la simulación, sólo queda ejecutarla.

Para ello ejecutamos "Pspice>Run" en la barra de herramientas.

Si algo ha fallado, se ejecutará correctamente el programa, pero al concluir

aparecerá una indicación con los errores que hemos cometido o bien en el esquema o en

la configuración.

Por ejemplo en este caso estaría indicando que:

Dos nudos, el N00009 y el N00437 no tienen referencia de tensión. Esto suele ser

debido a tener el esquema, o parte de él sin tierra

El tercer error es debido a que hemos puesto una inductancia en paralelo con un

pulso de tensión.

Una vez corregidos los errores, volvemos a ejecutar el circuito, y se deberá abrir esta

ventana:
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En este caso es la ventana correspondiente a un análisis transitorio. Dentro de la

ventana principal, aparecen otras tres ventanas: las dos inferiores informan, de cómo se

ha ejecutado la simulación (la ventana de la izquierda), y de cómo estaba esta

configurada, mientras que la central nos da el resultado.

Si se quiere modificar la escala de la simulación, es suficiente con hacer doble

clic sobre cualquiera de los dos ejes. Aparecerá un desplegable que por un lado

permitirá seleccionar la escala (logarítmica o lineal) y los limites del eje en cuestión; y

por otro la configuración de la representación.

Nota: La escala logarítmica es útil para el trazado de diagramas de Bode.

Para conocer algún valor en concreto, un punto determinado de las gráficas,

existen los cursores. Estos se abren pinchando sobre el icono que representa una gráfica

roja marcada con un cursor (seleccionado en la figura).

Una vez seleccionado se abrirá una ventana donde aparecerá el valor del cursor

(Probe Cursor). Si se pincha sobre la gráfica se podrá desplazar el cursor sobre la
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función. El botón izquierdo controla un cursor, mientras que el derecho otro, pudiendo

evaluar, manejando ambos, distintos valores y sus diferencias. Si se quiere llevar un

cursor sobre un mínimo o un máximo local, así como sobre un punto de inflexión, con

el cursor seleccionado cliqueamos el símbolo que corresponda:

Nota: Los dos iconos de la izquierda informan sobre máximos o mínimos totales,

mientras que el cuarto y el quinto sobre locales. El tercero coloca el cursor donde halla

un punto de inflexión. El último marca el punto siguiente al punto sobre el que

tengamos el cursor.

Si se quiere señalar el valor de un punto determinado marcado por el cursor, hay

que pinchar en el icono de "Mark Label".

En la barra principal, "Trace" tiene distintas posibilidades como complemento de

la representación gráfica.

Con "Add Trace" se pueden representar simultáneamente varias funciones, o

incluso relaciones entre ellas (Diferencias, productos...).

"Goal Functions" da la posibilidad de calcular propiedades de las distintas

magnitudes. Como ejemplo se calcula el periodo de la tensión V(N00013).

En primer lugar se elige el tipo de cálculo que queremos realizar, en este caso el

periodo.
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Una vez seleccionado el periodo, hay que escoger la función de la cual se quiere

calcular el periodo, y presionar "Ok".

"Eval goal functions" da la posibilidad de calcular funciones que sean relaciones

(diferencias, productos) de las funciones que ofrecía "Goal Functions". Por ejemplo, el

producto del periodo por un máximo.

Importante: Si es necesario exportar datos a otro programa como pueden ser el

Matlab o el Excel, hay que proceder de la siguiente manera. Primero se selecciona con

el cursor la función con la cual se quiere trabajar.

Una vez está la función marcada (en rojo), se selecciona en "Edit" "Copy". Sólo

queda en Excel o Matlab hacer lo mismo pero seleccionando "Paste" o "Pegar".

También es posible sobre un fichero de texto. Nota: Excel da problemas de formato en

algunas de sus versiones al usar este método.

Si se selecciona ">Tools>Options", aparece el menú de opciones del programa

"probe".
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Desde esta ventana se configura la representación de funciones. Hay cuatro

opciones encuadradas, la primera controla los símbolos con los cuales se pueden

distinguir las diferentes funciones, la segunda hace lo propio con los colores. La tercera,

sirve para que en el caso de utilizar el zoom, aparezcan o no las barras que permiten

desplazarse por la función. Por último, la cuarta opción permite modificar el tiempo que

transcurre desde una actualización a otra de las funciones que representa el probe.

A la derecha hay cuatro opciones más, las tres últimas activan o desactivan las

ventanas que aparecen junto a la función (la ventana de errores, la de estadísticas y la de

evaluación). La primera es importante, "Mark Data Points"; como su propio nombre

indica, si se selecciona, marca en color, los puntos del gráfico que realmente ha

calculado.

Conviene recordar lo importante que resulta a la hora de entregar un trabajo, la

buena presentación de las gráficas que acompañen dicha práctica. Hay que señalar lo

que se está representando en cada eje (mediante su configuración), así como marcar los

puntos más significativos y comentar por qué lo son (insertando etiquetas).
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4. EJEMPLOS.

4.1 ANÁLISIS DE UN TRANSITORIO SIMPLE

Se va a estudiar la descarga de un condensador de 1nF, cargado inicialmente con

1V sobre una resistencia de 1k . Lo primero a realizar, sería el esquema. Hay que

modificar las propiedades del interruptor, ya que el valor de "Ttrans" que tiene por

defecto (1u) es demasiado grande para la escala de tiempos a utilizar. Usaremos un

valor de 1p.

El esquema no tiene ningún tipo de dificultad. Si se quiere estudiar la respuesta

de la tensión en el condensador, será suficiente con colocar un marcador donde se indica

en la figura. Es importante el hecho de que el marcador nos dará la tensión del nudo

respecto de tierra, no propiamente la del condensador en sí, aunque en este caso

coincidan. Si quisiéramos en otro caso calcular la tensión del condensador, habría que

poner un marcador diferencial.

Para realizar el análisis, primero hay que configurarlo. Después de realizar los

cálculos previos, de hallar la constante de tiempo y demás; la configuración que habría

que poner en este caso sería la siguiente:

Ejecutamos el análisis y obtendremos la siguiente gráfica:
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Aunque en este caso no halla pasado, es muy importante ver en este tipo de

análisis, como, si dejamos al programa que ponga ciertos valores por defecto pueden

ocurrir cosas que no se corresponden con la realidad. Un transitorio de este tipo tiene la

forma de la figura de la izquierda, mientras que Pspice lo podría llagar a representar

según la figura de la derecha.

Esto es debido a que Pspice no representa la función tal cual es, sino que va

calculando punto a punto y luego los une. Este efecto se puede amortiguar, y hasta

eliminar. Para ello, en el Setup bastaría con reducir la distancia máxima que hay entre

cada dos puntos en que se realiza la simulación.

Tardará un poco más en realizar el análisis, ya que estudiará más puntos, pero de

esta manera habrá menos diferencia con la realidad.

Este efecto se ve al representar una función que tenga un máximo por ejemplo.

Debido al efecto comentado, puede llegar a parecer que dicho punto se encuentra en un

instante distinto al real con un valor menor.
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Estas son dos gráficas que representan la misma función, pero con distintos

valores de paso. La primera es mucho más aproximada, es más, la segunda es errónea,

ya que representa como asimétrico algo que no lo es.

4.2 ANÁLISIS DE UN TRANSITORIO CON UN PARÁMETRO VARIABLE

En este caso vamos a estudiar como responde el siguiente circuito para distintos

valores de R (de 10 a 100 ), a la apertura del interruptor.

Para hacer el análisis de R variable, hay que seguir los siguientes pasos. Primero,

como si se estuviera escogiendo un componente, abrimos de la barra principal ">Place

>Part", y escogemos el componente "Parameters", que se encuentra en la biblioteca

"Special".

Una vez seleccionado, se podrá colocar el pseudocomponente en el esquema.
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Se pincha dos veces sobre él y se abre la ventana de propiedades del

componente, en este caso PARAMETERS.

Hacemos clic en "New", y ponemos el nombre del componente que vamos a usar

como variable (R en nuestro caso).

Aceptamos y aparecerá R como propiedad de PARAMETERS. Marcamos con el

botón derecho sobre R, como aparece en la figura y escogemos "Display". Sólo queda

salir de la ventana de propiedades cerrándola.

De los seis iconos de la figura hay que pulsar el de la derecha del la parte de

abajo, no el de arriba.

Una vez hecho lo anterior aparecerá en el esquema:
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Pinchando dos veces en R (debajo de PARAMETERS) se le da el valor por

omisión que tiene que tener R en el caso de que no se realizara el análisis paramétrico.

Hay que darle a la resistencia el valor de {R}, con lo cual indicaremos que no

tendrá un valor fijo, sino que será un parámetro del análisis.

A continuación se entra en el Setup, se configura el transitorio, y se selecciona

"Parametric Sweep". En el caso del ejemplo, se seleccionará "Global Parameter", y se

dará el nombre que tiene nuestro parámetro en el esquema, así como los valores inicial,

final y el incremento que queremos que tome de un valor a otro.
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Una vez está configurado el análisis, se puede ejecutar sin ningún problema. Se

elige "Run" y tras un corto intervalo de tiempo, aparece la siguiente ventana,

pidiendonos qué valores de los calculados queremos representar en nuestro estudio.

Por defecto aparecen seleccionados todos, se acepta y por fin se puede ver el

resultado.
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Para R pequeña, apenas se ofrece oposición al intercambio de energía entre la

bobina y el condensador, la señal es subamortiguada (el condensador descarga en la

bobina haciendo que esta se cargue, para luego descargarse en aquel sin apenas

disipación). Se observa como según R aumenta, hay más oposición al intercambio,

llegando este sólo a realizarse una sola vez para valores de R grandes

(sobreamortiguada).

4.3 DIAGRAMA DE BODE DEL CIRCUITO RLC SERIE.

Vamos a calcular el diagrama de bode de módulo y fase de la función de

transferencia que relaciona la tensión en el condensador con la tensión en la fuente del

siguiente circuito.

El montaje del esquema no es complicado, y una vez realizado, antes de poner

los marcadores, es necesario configurar la simulación.

Para configurar el análisis, abrimos la ventana del setup y elegimos "Acsweep".

Hay que indicar la escala (logarítmica), las unidades (Décadas) y las frecuencias de

inicio, la final y cuantas queremos tomar intermedias.
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Ya realizada la selección de barrido en alterna, se escogen los marcadores y se

colocan en el esquema. Tienen que ser marcadores avanzados, de fase y módulo.

Seleccionados los marcadores, se ejecuta el análisis y se obtienen los resultados:


